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WARNINGS Read Before Using Your Sega Dreamcast Video Game System 

CAUTION 
Anyone who usds the Dreamcast should read the operating manual for the software and console before operating Ilium A responsible adult 

should read these manuals together with any minors who will use the Dreamcast before the minor uses it. 

HEALTH AND EPILEPSY WARNING 
Some small number of people are susceptible to epileptic seizures or loss of consciousness when exposed to certain fleshing lights or light 

patterns that they encounter in everyday life, such as those in certain television images or video games. These seizures or loss of con¬ 

sciousness may occur even if the person has never had an epileptic seizure. 

If you or anyone in your family has ever had symptoms related to epilepsy when exposed to flashing lights, consult your doctor prior to using 

Sega Dreamcast, 

In all cases, parents should monitor the use of video games by their children. If any player experiences dizziness, blurred vision, eye or mus¬ 

cle twitches, loss of consciousness, disorientation, any involuntary movement or convulsion, IMMEDIATELY DISCONTINUE USE AND CON¬ 

SULT VOUtt DOCTOR BEFORE RESUMING PLAY 

To reduce the possibility of such symptoms, (he operator must follow these safety precautions at all times when using Dreamcast: 

* Sit a minimum oF 6.5 feet away from (he television screen. This should be as far as the length of die controller cable. 

* Do not play if you are tired or have not had much sleep. 

* Make sure that the room in which you are playing has all the lights on end is well lit. 

* Stop playing video games for at least ten to twenty minutes per hour. This will rest your eyes, neck, arms and lingers so that you can 

continue comfortably playing the game in (he future. 

OPERATING PRECAUTIONS 
To prevent personal injury, property damage or malfunction: 
* Before removing disc, he sure it has stopped spinning. 

* The Sega Dreamcast GD-ROM disc is intended for use exclusively on the Sega Dreamcast video game system. Do net use this disc in any 
thing other than a Dreamcast console, especially not in a CD player. 

* Do not allow fingerprints or dirt on either side of the disc. 

* Avoid bending (he disc. Do not touch, smudge or scratch its surface. 

* Do nut modify nr enlarge the center hole or the disc dr use a disc that is cracked, modified or repaired with adhesive tape, 

* Do not write on or apply anything to either side ol the disc. 

* Store the disc in Its original case and do not expose it to high temperature and humidity. 

* Do not leave Ibe disc in direct sunlight or near a radiator or other source of heat. 

* Use lens cleaner and a soft dry cloth to clean disc, wiping gently from the center to the edge. Never use chemicals such as benzene and 

paint thinner to clean disc, 

PROJECTION TELEVISION WARNING 
Still pictures or images may cause permanent picture tube damage or mart the phosphor of the CRT. Avoid repeated or extended use of 

video games on large-screen projection televisions. 

SEGA DREAMCAST VIDEO GAME USE 
This GO-ROM can only bo used with the Sega Dreamcast video game system. Do not attempt to play (his GD-ROM on any oilier CD player; 

doing so may damage the headphones and/or speakers. This game is licensed for home play on the Sega Dreamcast video game system 
only. Unauthorized copying, reproduction, rental, public performance of this game is a violation of applicable laws. The characters and 

events portrayed in this game are purely Fictional. Any similarity to other persons, living or dead, is purely coincidental. 

Thank you for purchasing Duttrigger, Please note that this software 
is designed only for use with the Dreamcast console. Be sure to read 

this instruction manual thoroughly before you hag in playing. 
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Game 1 n S Blocks 
File »S3 Required 

Outtrlgger requires the use of a memory card to save/load 
game data. For details on saving and loading, see p 18. 

While saving or loading, never turn the Dreamcast power 
OFF, attempt to remove the memory card or disconnect the 

controller containing the memory card. 



STORY 
In response to a series of high casualty terroist attacks to its military 

research facilities, Visitaria, a multinational corporation involved with 

military and space industries, established training facilities to prepare 

members far entry into an elite unit known as the International Counter¬ 

terrorism Special Force* Handpicked from various special forces groups 

from around the world, the first squad of highly trained, male and female 

soldiers are set to begin a harsh and violent program designed to 

transform them into the world's ultimate counter-terrorism weapon. 

As a member of this squad, your goal is to vie for supremacy among your 

fellow trainees. Utilize the various weapons at your disposal while learning 

to capitalize on your strengths and minimize your weaknesses in the various 

missions available. Get to know your opponents and master the techniques 

required to dispose of them quickly and effectively in the versus mode. Then 

go online and use every ounce of your cunning and tactical experience to 

exert your dominance on the Outtrigger network. 
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STARTING A GAME 
Load Che Outtrigger game disc into your Dreamcast and turn the 
power ON. If you haven't already inserted a memory card into an 
expansion socket of any controllers] connected to Control Ports 

• or D, you will be requested to do so, 

more than one memory card, or previously created Outtrigger 
game file is available, use # ♦ # # to designate which game file 
to load. Once the selected memory card and/or file is verified, 
the game will load. Press the Start Button to proceed to the title 

SAVING fi LOADING 

Each Outtrigger game file requires B free mem pry b locks to save. 
In general, saving and loading of game data will occur automatically 
to the file designated at the start of gameplay. For details on saving 
or loading data manually, see p. 18. 

MAIN MENU 

CAUTION 
Never touch the controller Analog Thumb Pad cr the Triggers 11/H while turning the Oreamcast 
power ON, Doing so may disrupt the controller inrtializaEim procedure and result in malfunction. 

From the title screen, press the 
Start Button to display the 
mode selection screen. Use # 
# to select a game mode and' 
press © to enter. For details on 
the modes available, refer to 
the corresponding page 
numbers listed here. 

ARCADE MODE 



BASIC CONTROLS 
Outtrigger is a one to four player game 

OFFLINE [and 1-6 players ONLINE) that can be 
played using either the Dream cast Controller 
or Keyboard as a main device. Connect the 
device to be used by each player to a 
corresponding Control Port A, B. C or D. 

A sub-device (such as the Dreemcast Mouse, 
etc.) can also be used to play, however doing 
so reqires the use of two ports for each 
player [one port for the main device and one 
for the sub). See the following diagrams for 
examples on device setup: 

DREAMCAST CONTROLLER 

i Trigger □ 

Analog 
Thumb Pad! 

Directional 
Pad [D-Pad) 

s ® Button- ^ 

Q Button © Button 

' - Button.- 

Start Button 

DREAMCAST KEYBOARD 

E) 1- LI HI I ' ihiliMM ir-l^t-l|ir.| 1 
Ml- LT LTTT.H-.iFil |; i| i|i-; 

twWrtt:? TljrnTT^ FFFl UJ LI i - L i 
rirfl- Ilf V V WffiattWEJ 

1 , FWnrm t i r- -! 1 1 fi 
E=ILilfcJC JJ: •!!■ F1FTF1 ffi m ; 11 J [j 

To use the Jump Pack [sold separately) 
when playing, always he sure to insert the 
Jump Pack into Expansion Socket 2 cf the 
Dreamcast controller, Note that the Jump 
Pack can not be used with the keyboard, 
k_=_-Jf. 
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and so on... 

BASIC CONTROLS 
DURING MENU SELECTION 

CONTROLLER _ 

DURING GAME PLAY 

Q Button 

© Button 

Select 

Enter 

Cancel 

Arrow Keys 

Enter Key 

Escape Key 

iSfl IJHi 

KEYBOARD 

Refer to the following chart for a summary cf the commands assigned as the default control settings 
[Control Method A] for the following mein devices. For details on alternative settings, see p. B. 

m 
CONTROLLER 

Start Button 

□ Pad * 

D-Pad* 

□ Pad * 

D-Pad m 

Analog Thumb Pad • 

Analog Thumb Pad ♦ 

Analog Thumb Pad ♦ 

Analog Thumb Pad ♦ 

DEFAULT CONTROLS 

Display the Pause Menu 

Move Forward 

Move Right 

Move Backward 

Move Left 

Rotate View Left 

Rotate View Right 

Jump 

Toggle View 

Fire Weapon 

Toggle Weapon 

Rotate View Upward 

Rotate View Right 

Rotate View Down 

Rotate View Left 

01 

KEYBOARD 

Pause - Break 

Arrow Key w/Number Pad S 

Arrow Key ^/Number Pad 6 

Arrow Key •/Number Pad 3 

Arrow Key ♦/Number Pad 4 

S 

Z/ Delete 

Tab/Insert 

Space/Page down 

C/End 

To soft-reset the Dreamcast and return to the title screen during game play, simultaneously press 
and hold the ©, ©, ©, © and Start Buttons [Keyboard: Control, Alt & Delete). 
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BASIC CONTROLS 

ALTERNATIVE COMMAND SETTINGS 
The following diagrams show the main alternative command methods available. Note that each main 
method (A, B, etc ] has and additional three types of configuration (e.g., method A1. A2 end A3) 
available. Experiment to determine the control device and configuration setting that is right for you. 

CONTROLLER B c D KEYBOARD ET B 
UP Look Up Look Up Look Up * . i Look Lfp 

Analog R]GHT Look Right Look Flight Look Right i q 
• 

Look Right 
Thumb -•! r. 

pad DOWN Look Down Look Down Look Down ♦ ... 
Look Gown 

LEFT Look Left Look Left Look Left ♦ , i:..j 
: Lopk Left 

Move Forward Toggle Weapon E 
:--y : Move Forward 

I 
4 :r _ Move Right _ D .. 1 ! 

Move Backward 
□-Pad T 

Move Backward — y Toggle View S iMoye Left 
m T 

I nJT- Move Left - F. 
V i. ■ k Move Right 

TRIGGER □ Move-Flight Move Foiward Fire Weapon SPACE & Fire Weapon 

TRIGGER D Move Left Move Backward Jump 2 i r § j- Jump 

© BUTTON Fire Weapon Fire Weapon Move Backward G r r'-'- jj- Toggle Weapon 

©BUTTON Jump Jump Move Right T AG f. j [5^1 [fff! 
k=< Toggle View 

© BUTTON Toggle Weapon Toggle Weapon Move Left w ffiu - 

0 BUTTON Toggle View Toggle View Move Forward 

SUB-DEVICE 

The following chart lists the command settings available when using a sub-device, such as the 
Dreamcast Mouse, to supplement a main device for game play. 

TYPE A B C D E F G H i J K L 

Fire Weapon H DDDBQI9 mm EH dod 
Jump El BDBDDO WM DBD 

Toggle Weapon M 

Toggle View FI fa BQQ 
= Left Click jjl = Side Click El = Right Click 
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GAME DISPLAY 
1 PLAYER MODE 

QUIT GAME 

After pausing, select and enter one of the following items: 

Close the pause menu and continue playing. 

Make various device setups. 

End the current game and return to the title screen. 

0 POINTS 
The current number of points earned. 
0 REMAINING OPPONENTS 
Indicates the number of opponents you must 
eliminate in order to complete the mission. 
(Arcade Mode and Mission Mode only) 
0 SIGHT 
Use to aim The shape will vary according to the 
weapon used. 
0 OPPONENT CURSOR 
Appears on an opponent when in range. Color 
indicates when the opponent will attack 
[red = imminent]. In ''Highest Point Total'' missions, 
the opponent's cursor is always red. 
0 TIME 
The allotted time remaining. A session will end when 
this reaches zero if the mission objectives are not 
completed. 

0 RADAR MAP 
Shows the position of your opponents [red] relative 
to your position [green], 
(Arcade and Mission Modes only). 
O STRENGTH GAUGE 
Indicates your physical strength. This gauge will 
decrease when damage is inflicted by an opponent. 
If it reaches zero, your character will go down and 
you will restart. 
0 WEAPON & AMMO 
indicates the weapon currently in use and amount 
of ammo remaining. 
0 TOTAL ELAPSED TIME 
© COMBO GAUGE 
When an enemy is shot, this gauge turns to green. 
Shoot the next enemy before this gauge turns to 
earn combo points 
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GAME DISPLAY 

VS MODE 

The appearances can 
be charged bv pressing 
the © Button. 

0 POINTS 

The current number of points earned. 
G STRENGTH 
Indicates your physical strength. This value will 
decrease when damage is inflicted by an opponent. 
If it reaches zero, your character will go down and 
you will restart. 
© WEAPON & AMMO 

indicates the weapon currently in use and amount 
of ammo remaining. 

O TIME 
The allotted dma remaining. A match will end when 
this reaches zero. 
0 OPPONENT CURSOR 
Appears on an opponent when in range. 
0 SIGHT 
Use to aim. The shape will vary according to the 
weapon used. 

After pausing, select and enter one of the following items: 

Close the pause menu and continue playing. 

Change device setup. 

Exit the currant game and return to the RULES menu. 

End the current battle and return to the title screen. 
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GAME MODES 
ARCADE MODE 

Select this one-player mode to participate in a series of four training courses (Preparatory, 
Novice. Intermediate and Advanced] ported from the arcade version of Outtrigger Use this 
mode to hone your battle technique and build your weapon skills. 

Press the enter key of the main device you will use. To use a sub-device in 
conjunction with a main device, only press the enter key of the sub device. 

Next, use 00 to select a character and enter 
your selection. Then, use 00 to select and 
enter three alphanumeric characters to identify 
your character. 

1* .t. 

10-;! !®0! '55ft; 

PLAYER SETUP 

Select to change the identifying color or 
weapon settings of your character. 

DEVICE SETUP 

Select to change the control settings of 
the designated devices. 

CONTROL ASSIST 

Use 00 to toggFe ON or OFF, Ef ON, set 
the SENSITIVITY to the desired setting. 

Use < ► to select a color. 

WEAPON 1, 2 AND 3 

Use 00 to select a weapon and 
00 to select a weapon type 

CONTROLTYPE 

Use 00 to select control method. 

Use 00 to select NORMAL or REVERSE. 

Once the above settings are complete, select and enter OK. 

Next, use 00 to select the course of training you wish to undergo and then 
enter your selection. Once the game loads, the first mission will begin. Reed 
the instructions and complete the mission objective i 
successfully to continue on to the next mission and sc 
on until you have completed the entire course. 

Even if you fail to complete a mission, you will have a chance to continue play. 
To continue, press the Start Button before the countdown reaches zero to 
restart from the last attempted mission. 
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GAME MODES 

VS MODE 
Select this one to four-player mode to participate in battles where it's every player for 
themselves or divided into opposing teams. In the one player mode, you'll battle against CPU 
opponents on a full screen. When playing with 2 or more human opponents, you'll battle on a 

half or quarter split-screen. 

RULE SELECT 
Use ## to select an item and ** to adjust each setting as required. Press START to advance. 

Set to TIME LIMIT or POINT LIMIT. 

Set the total number of points required to win (1 - 5D], 

Bet the time at which the battle wilt end (2'00 - PO'OO). 

Set the number of sets required to win the match (1 -5) 

ON: When the current leader is defeated they will drop a Gold Medal worth 2 points. 

GAME TYPE 

MATCH POINT 

TIME UMIT 

MATCH COUNT 

HANDICAP 

TEAM BATTLE 

OFF: When the current leader is defeated they will drop a Silver Medal worth 1 point. 

Set whether to enable or disable team play. 

Note: MATCH POINT is disabled, if TIME LIMIT is selected as GAME TYPE. 

SETTINGS 

Each player must complete the device and character settings as described in the SETTINGS 
section on p. 9 {see the outlined box at the center of the page]. Once these settings are complete, 

select OK. _ 

Next, each player uses to select a group (Team) and enter your 
selection. This item is only available when the TEAM BATTLE feature is 
enabled. 

Si: t3E jpySpfcffi ad 

f^HaHOW Use to select and enter the stage on which the battle will take 
place. Once the game loads, the battle will begin. 
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GAME MODES 

When you play the VS MODE by yourself, the three latest actions that has happened in the game 
will be displayed at the top right side of the screen. 

Once the battle is over, the ranking of each participant will appear 
followed by the results screen. .u. 4 

3m ' & “ffl 

Select and enter an item from the displayed menu to either continue 
versus mode play or exit to the title screen. 

CHANGE STAGE 

CHANGE RULES 

Retry using the exact same settings (no load time]. 

Opt to reselect the stage only 

Opt to modify the battle rules. 

Exit the versus mode and return to the title screen. 



GAME MODES 

NETWORK BATTLE MODE 
Select this 1-6 player mode to connect online to battle against other players over the Internet. 

If you have not already configured ISP settings to your Dreamcast, use your 
Dreamcast browser disc to do so. Refer to the Dreamcast Browser instruction 
manual for details. To request a Dreamcast browser disc call 1-800-500-6946. 

SETTINGS_ 

Complete the device and character settings as described in the SETTINGS section on p. 9 [see 
the outlined box at the center of the page). Once these settings are complete, select OK. 

Note: If you ere using the Dreamcast Keyboard for chatting, you must have it connected before 
you proceed any further Once the setting is made, it will not be recognized until you exit the made. 

CONNECTING ONLINE 

Follow the direction shown on the screen to connect to the network server. LtjteJrt .KM.-S 

Once connected, LOGIN GAME SERVER menu will be displayed. Enter your 
name to be used inside the server (player name), and select Login DK to ■STffiTJS ■ •• ! 
enter the server , i 

| CAUTION . . 1 
Although there is an option to change game server name, there exists only one server. As this 
option is strictly for possible future enhancement, please leave this parameter as is, without 

changing. __ 

ENTERING A LOBBY 
Once you ere in the server; a SERVER MENU window will be displayed- Use 
## to select the menu item, and press © to enter When you select Join 
a lobby, a list of available lobbies will be displayed. Use ## to select the 
lobby to enter, and press © to enter. 

The LOCATION window, displayed at the bottom of the screen, indicates 
your current location in the server. 
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GAME MODES 
INSIDE THE LOBBY 
Inside the lobby, two windows will be displayed: LOBBY MENU window and OPERATION LOG window. 
On the LOBBY MENU window, a list of menu items [commands you can perform in the lobby) will be 
displayed. On the OPERATION LOG window, the actions that has taken place inside the server 
[players' entrance to/exit from the lob by/room, chat messages, etc.) will be displayed. Press © to 
switch the window to be active. 

OPERATION LOG-j 
$» 

JTps 
wife 

- LOBBY MENU 

Join a room Select this to display the list of currently available roams. Use to 
select the room, and press © to enter, if a password is needed to enter 
the roam, you will be prompted to do so. 

Create a room Create □ room to have battle. See p, 14 for details. 

Lobby chat Use the on-screen software keyboard or the Dreamcast Keyboard to 
chat with other players in the lobby. The message wiFI be displayed on the 
OPERATION LOG window. 

Show Lobby members 

Leave this Lobby 
Logout 

Display the list of players in the current lobby. The list will be displayed on 
the OPERATION LOG window. 

Leave the current lobby. 

Disconnect from the network [server] and return to the mode selection 
menu. 

Note: The server name and lobby name appearing in the screenshots here are temporary. 
The actual server/lobby names may be different. 
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GAME MODES 
CREATING A ROOM 

The network battle takes place inside a room in the lobby. You can enter 
any currently available roam, or create cne, If you create a room, you 
became the owner of the room, and the room will exist until all room 
nnembers leave the room. If the current owner leaves first, then another 
room member becomes the new owner. To create a room, select Create a 
room from the LOBBY MENU A ROOM CREATION menu will be displayed. 
Set the following parameters, and select Create OK to create a room. 
Press © to return to the LOBBY MENU without creating a roam (cancel]. 

room name Enter the name for the room to create 

password 

maximum players 

If you wish to create a room for selected participants, enter a password 
to enter the room you create. You may leave this a blank, if you wish to 
have the room open to everyone in the lobby. 

Establish the maximum number of participants in the room [1-6 players]. 

INSIDE THE ROOM 
Inside the room, you can start the network battle The game can be played 
the same way as the VS MODE. Utilize the chat to agree, with one another, 
on the rule to be played. 

Once inside the room, a ROOM MENU will be displayed. 

Game Settings You can change the rule of the game. Only the 
owner of the room can select this menu item. 

Start game 

Player Settings 

Team Select 

Show room members 

Leave this room 

Start the battle. Only the owner of the room can select this menu item. 

You can change the character to be used 

Select the team. This menu item is available only when the TEAM BATTLE 
feature is enabled by the room owner. 

As in Lnbby chat, use to communicate with others in the room. 

Displays a list of members in the room in the OPERATION LOG window. 

Leave from the room to the lobby. 

Disconnect from the network [server] and return to the mode selection 
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GAME MODES 

MISSION MODE 
Select this one-player mode to participate in a series of missions divided into three levels of 
15 missions each Initially only the first five missions of the Novice level will be available for 
selection. You will need to clear these missions in order tc unlock the next cluster of five 
missions and then clear those to unlock the last cluster of four missions The 15th and final 
mission of a level can only be unlocked if ycu clear all the previous 14 missions. 

SETTINGS_ 

[Complete the device and character settings as described in the SETTINGS section on p, 9 (sea 
the outlined box at the center of the page]. Once these settings are complete, select OK. 

Use to select a level (Novice, Intermediate or Advanced) and 
then press enter Next, use to select a mission from the 
available options and then press enter. If you wish to modify your 
player settings, select PLAYER SETUP. Otherwise, after you have read 
the mission objective, select OK to begin. Select EXIT to return to the 

mode selection screen. 

Once the gome loads, your mission will begin. Read the instructions 
and complete the mission successfully to continue on to the next 
mission, and so an until you have completed the entire level 
Whenever you successfully complete a mission, an emblem will appear 
under that mission s number on the mission selection screen. 

This emblem indicates that 
a mission is complete. 

Regardless of whether you successfully complete dr fail a mission, you 
can retry for a better score. Use to select either EXIT or RETRY. 

Exit and return to mission mode selection screen. 

Restart from the last attempted mission 

15 | 



CHARACTER EDIT 
Select this mode to modify the color end weapons settings to create your own original 
character that you can use to battle against other players in the versus or network versus 
battle modes. Weepons that are normally not available to a particular character can be 
selected as well as weapons that usually must be found on the battle field such as the 
Photon Torpedo or Flame Thrower. Meeting certain requirements in arcade or mission mode 
play will unlock new character types and weapons for use here. 

CHARACTER SELECTION SCREEN 

Use + + to select one of the four character 
files available for editing and then press enter. 

IMGft 

- jit, 
#V 
f in 1 Siiintjj 

ISlext, use to select a 
character type from the 
available options and then 
press enter. 

PLAYER SETUP 

Use to select three alphanumeric characters to 
identify ycur character 

COLOR 

Use ++ to select a colon Then press #. 

WEAPON SETTING 

Use *# to select a weapon catagory [1 ,2 and 3) 
and then use ++ to select a weapon type. 

□nee the settings are complete, use # to select OK and press enter to save these settings. Select 
CANCEL to exit without saving. 

16 

OPTIONS 
Select this mode to modify various game settings, save/load game data nr conduct sound 

tests. 

ITEM 

SAVE TYPE 

AUDIO 

SAVE 

_LOAD_ 

SOUND TEST 

MOVIE TEST 

VIBRATION 

CONTINUE 

INITIAL VIEW 

ARCADE GAME LEVEL 

BBA ISP SETTINGS 

EXPLANATION 

Set the date save method to AUTO or MANUAL. 

Set the sound output to STEREO or MONO. 

Select to manually save the current game data or settings. See p.18 for 

details. 

Select to manually load game data or settings. See p.18 for details. 

Select to display the sound test menu. See p.18 for details. 

View movie. [Not available until certain requirements are met] 

Select to enable or disable Jump Pack function. See p.19 for details. 

Set tc enable or disable the continue feature. 

Set the default view setting to either CHARACTER or WEAPON. 

Set the arcade difficulty to EASY, NORMAL, HARD or VERY HARO. 

Select and enter this to change ISP settings if using a Broadband 
Adapter. See p.19 for details. 

Select and enter this to return the options settings to the default settings. 

Select to save the options settings and return to the mode selection menu. 
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OPTIONS 

SAVE/LOAD 
When you either save or food 0 gome file, a Memory Card Select screen 
wifi be displayed with each icon representing the Controller 
Port/Expansion Socket location. Memory card icons connected with a 
game file will be displayed brightly; memory card icons without game fifes 
will he displayed; dark. Only a silhouette will be displayed with the locations 
without memory cards. Use to select the memory card, and 
press © to enter Press © to return to the Options Menu screen. 

Memory Card with Game File 
If saving, the game file will be overwritten. You will be confirmed of your 
action. Press © to overwrite, and © to cancel. If loading, the game will 
load the file and returns to the Options Menu screen, 

Memory Cord without Game File 
Saving or loading, you will be asked whether to create a new file or not. 
Press © to create a new file; press © to cancel 

SOUND TEST 
When the Sound Test Menu screen is displayed, use ## to select 
menu item, and to change the value. 

BGM TEST 

SEPACK 

SE TEST 

BGM VOLUME 

SE VOLUME 

Listen to the background music. 

Select the pack number of the sound effects. 

Listen to the sound effects of the selected pack. 

Adjust the volume setting for the background music. 

Adjust the volume sotting for the sound effects. 

For BGM TEST and SE TEST, press © to play the selected music or 
the sound effect. 
To return to the Options Menu screen, press © 
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OPTIONS 

VIBRATION 
You can enable and disable Jump Pack setting for each Port separately. 
Use ## to select a port and ++ to toggle each setting to ON or OFF. 

V lirtAT 1 m< 

ISP SETTING 
If you are connecting to the internet with the Broadband Adapter (sold 
separately], you can configure the network settings here. For proper 
values for each parameter (IP Address, Subnet Mask, etc,), refer to the 
instruction booklet of the ISP you are contracted with. 

Note: If you are connecting with the 56K modem, configure the network 
setting with the Dreamcast browser disc. 

Entering the Value 
First, use to select the parameter to change and press © You will 
then enter the value for the parameter. You can use either the Dreamcast 
Controller or the Dreamcast Keyboard to enter values. If you are using the 
Dreamcast Controller, use to select the numeral, and press 0 to 
enter. To backspace (erase the previous letter], press ©. When you are 
done, press © to complete. 
If all parameters are completed, select SAVE TO FLASH to save them to 
the onboard memory. 

BroadMuel Se*up ftre«i 
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ITEMS 
A number of the items and weapons available in Outtrigger are as follows: 

Grab thfs item to 
increase your ammo 
by 5 rounds. 

This will absorb damage 
inflicted until the armor 
gauge {appears above 
the strength gauge] 
runs out. 

This will replenish ynnr 
strength gauge by a set 
amount. 

POWER UP 
This item will enhance 
your aim, attack power 
and speed for a set 
amount of time. 

THERMOGRAPHY 
These goggles enable 
you to see through 
objects, such as walls, 
for a set amount of 
time. 

These goggles enable 
you to see at right as 
if it were day. 

TIME +5 
Grab this to increase 
ycur time limit by five 
seconds (only available 
in the 1P modes]. 

SNIPER'S RIFLE | FLAME THROWER ■ GUIDED MISSILE | PHOTON TORPEDO 
Can dispose of an 
enemy in one shot. 
Press fire to activate 
the zoom sight and 
again to fire. 

Note: Thermography appears with green lenses: Noctovision with blue 
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This quick acting and 
powerful weapon can 
only be used at 
close-range. 

Missiles fired by this 
weapon will 
automatically home in 
on their target. 

Bullets fired by this 
weapon will bounce off 
of objects such as 
walls before striking. 

Fires four shots at once. 
Although it does not have 
strong fire power, you can shoot 
rapidly and accurately because 
it b Easy to aim. 

High on firepower, hut harder to 
aim. Bombs will be effective on 
enemies hiding behind wall or 
where you can’t shoot in a 
straight line. 

ROCKET LAUNCHER 
Has very high fire power, as you 
an defeat the enemy with two 

shots. You can also use the 
explosion to cause damage. 

From speed of movement to 
weapon efficiency, JAY offers the 
most balanced range of skills. 

Nationality: British 

Gender: Male 

Date of Birth: Apr. 13, 1972 

Height. 5'£T 

Weight: 165 lbs. 
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CHARACTERS 

ALAIIU CIEL 
ALAIN offers exactly the same 
skill level as JAY, 

Nationality: French 

Gender: Male 

Date of Birth: Oct. 4, 1971 

Height;: 5'11” 

Weight: 171 lbs. 

WEAPONS 
SUBMACHINE GUN 

Fires four shots at once. 
Although it does not have 
strong fire power, you con shoot 
rapidly and accurately because 
it is easy to aim. 

GRENADE 
High on firepower but hander to 
aim. Bombs will be effective on 
enemies hiding behind wall or 
where you esn't shoot in a 
straight line. 

ROCKET LAUNCHER 

Has very high fire power as you* 
can defeat the enemy with two 
shots. You can afso use the 
explosion to cause damage. 

CHARACTERS 

LINA MIYAGI 
What UNA lacks in power she 
more than makes up for with 
her quicker speed and superior 
agility. She appeals to players 
who are more interested in 
evasive power than attacking. 

Nationality: Japanese 

Gender: Female 

Date of Birth: Apr. 12, 1975 

Height: 5’5" 

Weight: 145 lbs. 

WEAPONS 

SUBMACHINE GUN 

Fires five shots in one burst. A 

weapon that is easy to handle. 

MOTION SENSOR BOMB 
Sticks to the walls and ceiling 
for a given time, and explodes 
when someone approaches. 

55mm RIFLE 
This weapon lacks the explosive 
power of Rocket Launcher, but 
makes up for it with rapid fire 
ability. 
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CHARACTERS 

TALON GRANT 
WEAPONS 

Bursts from this gun do more 
damage than the Submachine 
Gun, but it doesn't fire as rapidly. 
You can also deflect shots 
against the walla. 

Upon Impact these grenades will 
slow down enemy movement, 
which allows you to attack while 
the enemy is neutralized. 

These Pockets fly faster and hit 
harder than any other but the 
rate of fire is below normal- 

HEAVY GRENADE 

RAILGUN 

TALON is a power-oriented 
character. While he may not be 
quick on h3$ feet, he does have 
the strongest attacks with any 
weapon. 

Nationality: American 

Gender: Male 

Date af Birth: July 7, 19G9 

Height: G’4” 

Weight: 210 lbs. 
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TACTICAL ADVICE 

With the rocket launcher equipped, press the jump and fire buttons simultaneously to perform this 
huge jump, Perfect for reaching high places or evading enemy fire. 

Combos 

When you defeat an enemy, a small gauge under the elapsed time turns green. As you defeat the 
next enemies before the gauge turns red. you will be awarded double, triple, end quadruple the 
amount of normal points as combo. Aim for the combo to get a high score. 

Blast damage can be inflicted from the explosion of the Rocket Launcher or Grenades, If you aim at an 
enemy that is very close, you will risk taking damage yourself. Use the Submachine Gun for close combat. 

Ydu can shoot down rockets fired at you with your machine gun, 
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NOTES 
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*THIS LIMITED WARRANTY IS VALID FOR U S. AND CANADIAN SEGA DREAMCASTSOFTWARE MANU¬ 
FACTURED FOR SALE IN AND PURCHASED AND OPERATED IN THE UNITED STATES AND CANADA, ONLY! 

Limited Warranty 
Sega of America, Ine. warrants to the origins! consumer purchaser thslthe Sega DreamcaslGD-ROM shall be free from defects in material 

and workmanship for a period of 90-days from the date of purchase. If a defect covered by this limited warranty occurs during this SO-day 
warranty period, the detective CD-ROM or component will be replaced free of charge. This limrted warranty does not apply if Uie delects 
have been caused by negligence, accident, unreasonable use, modification, tampering or any other causes not related to defective materials 

or workmanship. Please retain the original or a photocopy of your dated sales receipt lo establish the dale ul purchase for in-warranty 
rnplacement. Far replacement, return the disc, with rts original packaging and receipt, to the retailer from which the software was originally 
purchased. In the event that you cannot obtain a replacement from the retailer, please contact Sega to obtain support. 

Obtaining technical support/service 
To receive additional support., ineloding troubleshooting assistance, please contact Sega at weh site (http://www.segaxom/cu slumsr_ser- 

vice!, e-maif (support@sega.coml, or 800 number (1 -8DQ-U5A-5EGAL Instructions en fran^ais, tilephooer au (t-80G-&72-7342). 

LIMITATIONS ON WARRANTY 
ANY APPLICABLE IMPLIED WARRANTIES, INCLUDING WARRANTIES DF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, 
ARE HEREBY LIMITED TO gg-DAYS FROM THE DATE OF PURCHASE AND ARE SUBJECT TO THE CONDITIONS SET FORTH HEREIN. IN NO 

EVENT SHALL SEGA OF AMERICA, INC., BE LIABLE FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES RESULTING FROM THE BREACH OF 
ANY EXPRESS OR IMPLIED WARRANTIES. THE PROVISIONS OF THIS LIMITED WARRANTY ARE VALID IN THE UNITED STATES ONLY. SOME 
STATES DO NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS, OR EXCLUSION OF CONSEQUENTIAL OR INCIDEN¬ 
TAL DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU. THIS WARRANTY PROVIDES YOU WITH SPECIFIC 

LEGAL RIGHTS: YOU MAY HAVE OTHER RIGHTS WHICH VARY FROM STATE TO STATE. 

ESRB RATING 
This product has been rated by the Entertainment Software Rating Board. For information about Ihe ESRB rating, or to comment about the 

appropriateness of the rating, please contact the ESRB si 1-BD0-771-3772. 

Si?(t3 is registered in lie tt.S Patent.lild Trademark Office. Sega, Dreamcas', Itte Brsamcas] toga, and Outrigger are eHher registered trademarks nr trademarks cl Saga 

Corporation, this gamo is tip eased tor use wtfi the Sega Dreomcort system only Copying and/or transmission of this game is strictly prohibited. Unaatlterited menial w 

(Hibjfc performance efihis game is a violation of applicable laws. ©SEGA COfiPGflAllDM, 2001. Sega □! Americ a Oreamcast, Ire. P.O. Ho* 7639, San Francisco, CAStlH, 

All Rights Reserved, wvw.wgaAim Programmed in Japan, Made and printed ir USA. Product covered under ere or morn of ihe foliowirg: U.S. Paiente No's: 

MGW W7iS5; 5,638.171 AMU>^ WW.W#: MgjDTfc 6,EQ2.30C Re. 35,S3St Japanese Peteri No. 2370533 [Patents pending in U.S. Bed other countries]; Canadian 

fater! Mo. Mftm. 


